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C H A P T E R 1

Configuring Cisco Unified Videoconferencing 
Connector Preferences

The Cisco Unified Videoconferencing Connector plug-in works with Cisco Unified Videoconferencing 
Desktop Server and IBM Lotus Sametime. You must configure Cisco Unified Videoconferencing 
Connector settings to be able to invite new participants into a Cisco Unified Videoconferencing 
Connector meeting. However, you do not need to configure these settings for accepting meeting 
invitations that you receive or for joining meetings created by other users.

 • Setting Cisco Unified Videoconferencing Connector Connectivity, page 1-1

 • Configuring a Permanent Meeting Room, page 1-3

 • Choosing How Sametime Will Display Meetings, page 1-5

For information about installing Cisco Unified Videoconferencing Connector plug-in, refer to the 
Installing and Configuring the Cisco Unified Videoconferencing Desktop Connector Plug-In.

Setting Cisco Unified Videoconferencing Connector 
Connectivity

This section describes how to configure connectivity between Sametime and Cisco Unified 
Videoconferencing Connector.

Procedure

Step 1 Select File > Preferences in the Sametime Connect user interface.

Step 2 Select the Video Meeting link in the left panel.

The Server tab is displayed as shown in Figure 1-1.
1-1
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  Setting Cisco Unified Videoconferencing Connector Connectivity
Figure 1-1 Server tab

Step 3 Enter the Desktop address in the Server field. 

This server will host Cisco Unified Videoconferencing Connector meetings initiated by you.

Step 4 If necessary, select the Port check box and enter a port number.

Step 5 Select Use a Secure Connection if Desktop is configured with HTTPS for secure conferencing.

Step 6 (Optional) If IBM Lotus Sametime Connect is configured to work with a proxy server and you want to 
change its configuration, perform either of these actions:

 • Either select Use the Sametime default community proxy settings

–or–

 • Select Use custom proxy settings and enter proxy host, port, secure connection and authentication 
information as shown in Figure 1-2.
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Figure 1-2 Proxy Server Area of the Server Tab

Step 7 Select OK to save your preferences.

Related Topics

 • Configuring a Permanent Meeting Room, page 1-3

 • Configuring a Meeting Room without a Room Number, page 1-5

How to Configure a Meeting Room
Cisco Unified Videoconferencing Desktop Server uses the meeting room you configure for a 
Cisco Unified Videoconferencing Connector meeting you create. When you leave the meeting, it still 
continues to run in your meeting room until all meeting participants leave this meeting.

 • Configuring a Permanent Meeting Room, page 1-3

 • Configuring a Meeting Room without a Room Number, page 1-5

Configuring a Permanent Meeting Room
You can configure Cisco Unified Videoconferencing Connector to automatically connect to a predefined 
room number each time you create a new video meeting. The room number is the service prefix used for 
the meeting followed by the meeting ID used by Cisco Unified Videoconferencing Connector. During 
this configuration you also define a PIN for PIN-protected meetings so that you do not need to enter a 
PIN upon meeting creation. Depending on your deployment you can configure a virtual meeting room 
in one of these ways:

 • For deployments using a MCU, you need to configure Cisco Unified Videoconferencing Connector 
to always use the same meeting room number and meeting PIN.

 • For deployments using an Cisco Unified Videoconferencing Manager, you configure Cisco Unified 
Videoconferencing Connector to retrieve information about your predefined virtual room from the 
Cisco Unified Videoconferencing Manager server.

Before You Begin

 • Acquire a service prefix from your system administrator.

 • Contact your system administrator to find out whether your Cisco Unified Videoconferencing 
Desktop Server is configured to work with a MCU or an Cisco Unified Videoconferencing Manager.
1-3
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Procedure

Step 1 Select File > Preferences in the Sametime Connect user interface.

Step 2 Select the Video Meeting link in the left panel.

Step 3 Select the Meetings tab.

The Meetings tab is displayed as shown in Figure 1-3.

Figure 1-3 Meetings tab

Step 4 To retrieve your virtual room information from the Cisco Unified Videoconferencing Manager server, 
select Use your virtual room number.

Step 5 To use a meeting room which is not your virtual room, perform these steps:

a. Select Use this room number.

b. Enter the meeting room you are using for this meeting in the Room Number field.

c. (Optional) If the room is PIN-protected, enter the PIN for the meeting in the Meeting PIN field.

Step 6 Select OK to save your preferences.
1-4
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Configuring a Meeting Room without a Room Number
When you configure a meeting room without a room number, Cisco Unified Videoconferencing 
Connector prompts you to enter the meeting ID which you want to use for your Desktop meetings. Each 
time the Cisco Unified Videoconferencing Connector starts, the Meeting ID dialog box opens prompting 
you to configure the meeting room number.

Procedure

Step 1 Select File > Preferences in the Sametime Connect user interface.

Step 2 Select the Video Meeting link in the left panel.

Step 3 Select the Meetings tab. 

The Meetings tab is displayed as shown in Figure 1-3.

Step 4 Select Always prompt for a meeting ID.

Step 5 Select OK to save your preferences.

Choosing How Sametime Will Display Meetings
You can choose one of these display options:

 • Embed the Cisco Unified Videoconferencing video meeting in Sametime client—To display the 
meeting interface within the Sametime client. If you start the video meeting by selecting the Connect 
to a video meeting panel (Figure 3-4), the video pane is added to the Sametime Connect Window, 
otherwise the video pane is added to the Chat window.

 • Launch the Cisco Unified Videoconferencing video meeting in separate window—To allow the 
meeting interface to open in a separate window. Using the separate window mode, you use your 
Desktop for room system application sharing and chat.

 • Call the specified number—To use a room system as your conferencing device. Configure an address 
of a third-party room system which you want to invite into a meeting. You can use an IP address, an 
E.164, or a SIP URL as the room system address. The room system address must be valid with MCU.

Procedure

Step 1 Select File > Preferences in the Sametime Connect user interface.

Step 2 Select the Video Meeting link in the left panel.

Step 3 Select the Meetings tab. 

The Meetings tab is displayed as shown in Figure 1-3.

Step 4 Select the relevant option in the Video Meeting Settings area:

Step 5 If you select the Call the specified number option, enter a valid address.

Step 6 Select OK to save your preferences.
1-5
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Installing and Configuring Conference Client

 • What is the Conference Client?, page 2-1

 • Preparing to Use the Conference Client, page 2-1

 • Methods for Accessing the Conference Client, page 2-2

 • Selecting a Language, page 2-2

 • Testing Audio Quality, page 2-3

 • Testing Your Video Settings, page 2-3

What is the Conference Client?
You need to install and configure the Conference Client to complete your deployment. The Conference 
Client is a component that automatically enables your Desktop with communication tools for audio and 
video meetings.

The Conference Client enables you to

 • View the IP address of your computer, system hardware and software information, and all the 
modules used by the Conference Client.

 • View the sent and received bandwidth for your local and remote endpoints.

 • Configure your preferences for the Conference Client.

Preparing to Use the Conference Client
You must install the Conference Client to participate in meetings. You can start using Cisco Unified 
Videoconferencing Connector with or without a video camera. 

Procedure

Step 1 If the Conference Client is not installed, or if your version needs to be updated, Cisco Unified 
Videoconferencing Connector automatically prompts you to do so.

Step 2 Follow the installation instructions.
2-1
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Step 3 Obtain and install a digital or analog video camera with a video capture card to send video.

Step 4 Make sure your computer is equipped with a sound card and a microphone to send audio, and a sound 
card with speakers or a headset to receive audio.

Methods for Accessing the Conference Client
You can access the Conference Client in these ways:

 • Select Preferences from the Actions menu. The General tab of the Settings dialog box opens.

 • Select Statistics from the Actions menu. The Current call window opens.

 • Select the Network icon (Figure 2-1) in the bottom right corner of the Cisco Unified 
Videoconferencing Connector user interface. 
The Conference Client Control Panel displays with the Current call section selected.

Figure 2-1 Network Icon

 • By selecting the Conference Client Control Panel icon (Figure 2-2) in the taskbar, and then 
selecting Settings.

Figure 2-2 Conference Client Control Panel Icon

Selecting a Language
You can change the language of the Cisco Unified Videoconferencing Connector user interface. The 
default language is the language set for the operating system. You can select one of these languages:

 • English

 • French

 • German

 • Italian

 • Japanese

 • Korean

 • Portuguese

 • Russian

 • Simplified Chinese

 • Traditional Chinese
2-2
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 • Finnish

 • Spanish

Procedure

Step 1 Access the Conference Client Settings by right-clicking the Conference Client Control Panel icon > 
Settings.

The General tab opens in the Settings window.

Step 2 Select Language in the left pane.

Step 3 Select the required language from the list.

Step 4 Select Apply.

Testing Audio Quality
Procedure

Step 1 Access the Conference Client Settings by right-clicking the Conference Client Control Panel icon > 
Settings.

Step 2 Select the Audio tab.

Step 3 Select Start audio test in the Playback pane.

Step 4 Select Stop audio test to end the test.

Testing Your Video Settings
Procedure

Step 1 Access the Conference Client Settings by right-clicking the Conference Client Control Panel icon > 
Settings.

Step 2 Select the Video tab.

Step 3 Select Preview in the Capture pane.

The Local Video Preview Window displays your configured video quality.

Step 4 Select Stop Preview to end the preview and to close the Local Video Preview Window.
2-3
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Creating and Connecting to a Meeting

 • Creating a Meeting, page 3-1

 • How to Join a Meeting, page 3-6

 • Adding Meeting Participants from a Chat Session, page 3-7

Creating a Meeting
You establish a Cisco Unified Videoconferencing Connector video meeting from the Sametime user 
interface. The pane displaying your video meeting can either be embedded into the Sametime Connect 
window (Figure 3-3) or the Chat window (Figure 3-5).

Upon a meeting creation

 • The initiator of the meeting automatically joins the meeting.

 • Each invitee receives an invitation to connect to the meeting.

 • Users who do not have the Cisco Unified Videoconferencing Connector plug-in installed receive a 
Sametime Instant Message with a URL for joining the meeting on a web page.

 • Users with other Instant Messengers using the IBM Lotus Sametime Gateway receive a Sametime 
Instant Message with a URL for joining the meeting on a web page.
3-1
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Creating a Video Meeting Embedded Inside the Chat Window

Procedure

Step 1 To create a video meeting from the Sametime Connect window, perform one of the following actions:

 • Select one or more entries from your Sametime contacts list and select the Cisco Unified 
Videoconferencing Connector icon. See Figure 3-1.

Figure 3-1 Cisco Unified Videoconferencing Connector Icon 

 • Right-click one or more entries in your Sametime contacts list and select Video Meeting.

 • Select one or more contacts from your list and select Invite to Video Meeting from the Tools menu.

 • Use CTRL+O keyboard shortcut.

-or-

Step 2 To create a video meeting from inside an existing chat session, select the Cisco Unified 
Videoconferencing Connector icon. See Figure 3-2. 
3-2
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Figure 3-2 Invitation from a Chat Session

The Video Meeting pane appears at the bottom of the Chat window. See Figure 3-3.
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Figure 3-3 Video Meeting Pane Embedded into the Chat Window

Note You can establish a new session after all participants have left the existing Cisco Unified 
Videoconferencing Connector session.

Creating a Video Meeting Embedded Inside the Sametime Connect Window

Procedure

Step 1 In the Sametime Connect window, select the Connect to a video meeting panel. See Figure 3-4.
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Figure 3-4 Connect to a Video Meeting Panel

Step 2 Enter the meeting ID.

Step 3 Select Add Video. 

The Video Meeting pane appears at the bottom of the Sametime Connect window. See Figure 3-5.

Figure 3-5 Video Meeting Pane embedded in the Sametime Connect Window
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How to Join a Meeting
 • Joining a Meeting as the Meeting Organizer, page 3-6

 • Joining a Meeting as an Invitee, page 3-6

Joining a Meeting as the Meeting Organizer
Table 3-1 describes how to join a meeting as the meeting organizer.

Related Topics

 • Setting Cisco Unified Videoconferencing Connector Connectivity, page 1-1

 • Adding Meeting Participants from a Chat Session, page 3-7

Joining a Meeting as an Invitee

Before You Begin

Make sure you have installed Cisco Unified Videoconferencing Connector plug-in. When you receive an 
invitation using an Instant Messaging session informing you of the room number and the name of the 
meeting organizer, select Connect at the bottom of the message.

Note If you disconnect from the Cisco Unified Videoconferencing Connector meeting but keep the Instant 
Messaging session open, you can return to the meeting using the same invitation message.

Table 3-1 Joining a Meeting as the Meeting Organizer

If you want to... Do this...

Join a meeting as the meeting organizer and if you selected 
the Embed the Cisco Unified Videoconferencing video 
meeting in Sametime client option or the Call the specified 
number option in the Video Meeting screen.

Ensure that you have filled the Server and Room Number 
fields in the Video Meeting preferences page, and then 
perform one of these actions:

 • Select one or more entries from your Sametime contacts 
list and select the Cisco Unified Videoconferencing 
Connector icon.

 • Right-click one or more entries from your Sametime 
contacts list and select Video Meeting.

 • Select one or more contacts from your list and select 
Invite to Video Meeting from the Tools menu. 
Alternatively, use the Ctrl+O keyboard shortcut.

 • Select the Cisco Unified Videoconferencing Connector 
icon from inside an existing chat session. See Figure 3-2.

Join a meeting as the meeting organizer and if you selected 
the Launch the Cisco Unified Videoconferencing video 
meeting in separate window option in the Video Meeting 
screen.

 • Enter your name and the meeting ID on the Join Meeting 
tab displayed in the bottom pane of the Sametime 
Connect user interface, and select Participate Now.
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Adding Meeting Participants from a Chat Session
You add meeting participants from a chat session by using the Invite others option. You can use this 
option as many times as you like; each time new users receive an invitation to a video conference.

 Procedure

Step 1 Unless you are already in a video call, select the Cisco Unified Videoconferencing Connector icon from 
inside your existing chat session. See Figure 3-2.

Step 2 Select the Invite others icon. See Figure 3-6.

Figure 3-6 Invite Others Icon

Step 3 Select invitees from the Invite Others dialog box.

Step 4 Select Send.

If the chat session uses the Cisco Unified Videoconferencing Connector plug-in, the invitee receives a 
Cisco Unified Videoconferencing Connector invitation. If not, the invitee receives an invitation using the 
chat application. 
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Moderating a Meeting

 • Inviting a User or a Room System, page 4-1

 • Performing Video Meeting Tasks, page 4-2

 • Changing the Video Layout, page 4-4

Inviting a User or a Room System
Procedure

Step 1 Select Invite from the Actions menu list.

Step 2 If you know the number or the address of the endpoint, perform these steps:

a. Select Invite by address from the list.

b. Enter a number into the Address field. 

-or-

Step 3 To invite a room system from the directory, perform these steps:

a. Select Invite a terminal from the directory from the list.

b. Select a terminal from the list.

-or-

Step 4 To invite a recently invited user or room system:

a. Select History from the list.

b. Select a terminal or a number from the list.

Step 5 Select Invite.

The Invitation Status dialog box displays the most recent invitations that you have sent together with an 
indication of whether or not each invitation was successful.

Step 6 Select Close to continue your meeting.
4-1
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Performing Video Meeting Tasks
Table 4-1 describes video meeting tasks that both moderators and participants can perform.

Table 4-1 Video Meeting Tasks Available for Both Moderators and Participants 

To do this... Do this...

Mute or unmute your microphone (not available for 
participants using a third-party room system) Select the Mute/Unmute Microphone icon .

Mute or unmute your speakers (not available for 
participants using a third-party room system) Select the Mute/Unmute Speakers icon .

Leave a video meeting  • If you use Cisco Unified Videoconferencing Connector 
embedded within the Sametime user interface or you use Desktop 
in a separate window, select Hang Up from the Actions menu.

 • If you use a third-party conferencing device, select Disconnect 
in the Sametime message.

The Cisco Unified Videoconferencing Connector login screen 
displays.

Note Disconnecting from the Cisco Unified Videoconferencing 
Connector portion of a meeting does not automatically 
disconnect you from the Sametime chat session. To leave the 
Sametime chat session, you must disconnect manually.

Rejoin a video meeting  • If you use Cisco Unified Videoconferencing Connector 
embedded within the Sametime user interface or you use Desktop 
in a separate window, select Cisco Unified Videoconferencing 
Connector icon.

 • If you use a third-party conferencing device, select Connect in 
the Sametime message.

Activate and deactivate video channels (not available 
for participants using a third-party room system)

 • Select the camera icon to turn your camera on and off from inside 
the video display.

Note In a double video display, the camera icon is located in the 
frame displaying the local video.

 • Alternatively, if you are using a double video display, you can 
right-click in your local video frame and select Local Video > 
Start or Stop.

Show pop-up messages By default, popup messages are suppressed during meetings. To 
enable the popup messages, choose Actions Menu > Show Popup 
Messages.
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Table 4-2 describes video meeting tasks that only moderators can perform.

Table 4-2 Video Meeting Tasks Available for Moderators 

Grant permission to speak for an attendee 
who used the Raise Hand option to request 
permission to speak

Select Grant Request from the Actions menu, and then select the attendee 
requesting permission to speak.

Lock a video meeting so new participants 
cannot join

Select Lock Down Meeting from the Actions menu.

Mute all participants except the moderator Select Mute from the Actions menu, and then select the Mute All Participants 
option.

Disconnect participants Select Disconnect from the Actions menu, and then select the required 
participant.

Disconnected participants are returned to the Cisco Unified Videoconferencing 
Connector login screen, but they are not disconnected from the parent web-based 
application session.

Mute or unmute a participant Select Mute from the Actions menu, and then select the name of the participant 
that you want to mute or unmute.

Block the video of a participant Select Block Video from the Actions menu, and then select a participant.

Unblock the video of a participant Select Block Video from the Actions menu, and then select a participant whose 
video is blocked.

Terminate a meeting Select Terminate Meeting from the Actions menu.
4-3
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Changing the Video Layout
Procedure

Step 1 Select Change View > 1 Video from the Actions menu to set a single video display. See Figure 4-1.

Figure 4-1 Single Video Display with Picture-in-Picture

Step 2 Select Change View > 2 Videos from the Actions menu to set a double video display. See Figure 4-2.
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Figure 4-2 Double Video Display

Step 3 Perform these actions as required:

 • Select the Undock icon  to float the toolbar and increase the size of the video frame.

 • Select the Camera icon  to turn your camera on and off.

 • Select the Remote video icon , and then select one of the following options:

 • Switch between Active Speaker and Continuous Presence views.

 • If in a High Definition meeting, switch between High Definition (HD) and Standard Definition 
(SD) video.

 • Pause or play the remote endpoint video.
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Step 4 If using the single video display, select the Picture-in-Picture icon  to create the video display 
shown in Figure 4-1.

You see yourself in the smaller Picture-in-Picture frame, and you see the other meeting participants in 
larger remote frames.

Step 5 If using the double video display, select the Swap Views icon  to swap the views displayed in the 
two video frames as shown in Figure 4-2.

You see yourself in one frame, and you see the other meeting participants in the other frame.

Step 6 If your video meeting pane is embedded in the Chat window, you can undock it by selecting the Undock 

icon . The video meeting pane appears in a separate window. 

To dock the video meeting pane, perform one of these actions:

 • In the Sametime Connect window, click Dock.

-or-

 • Close the Video Meeting window.
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Participating in a Meeting

 • Common Meeting Tasks, page 5-1

 • Requesting Permission to Speak, page 5-1

 • Viewing Meeting Information, page 5-2

Common Meeting Tasks
These tasks are common for both moderators and participants:

 • Muting your microphone

 • Muting your speakers

 • Leaving a video meeting

 • Activating and deactivating video channels

 • Changing the video layout

Related Topics

 • Table 4-1 in Performing Video Meeting Tasks on page 2

 • Changing the Video Layout on page 4.

Requesting Permission to Speak
If the moderator muted you and you want to speak, use the Raise Hand option to request to speak.

Note If the moderator muted you, this message displays: “You have been muted by the Moderator of the 
meeting.” when you select the Speakers icon.

Select Raise Hand from the Actions menu.

The moderator can grant or reject your request to speak.
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Viewing Meeting Information
You can view instructions for connecting to or dialing into your meeting that the Cisco Unified 
Videoconferencing Desktop Server administrator configures. You may want to send this information to 
other invitees.

Procedure

Step 1 Select the Display video meeting information icon in the upper toolbar, as shown in Figure 5-1.

Figure 5-1 Display Meeting Information Icon

The Meeting Information screen displays. 
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Troubleshooting

 • Troubleshooting Cisco Unified Videoconferencing Connector, page 6-1

 • Troubleshooting Conference Client, page 6-2

Troubleshooting Cisco Unified Videoconferencing Connector
 • Joining a Cisco Unified Videoconferencing Connector Meeting without Installing the Plug-in, 

page 6-1

 • Checking CPU Usage and Network Information, page 6-1

Joining a Cisco Unified Videoconferencing Connector Meeting without 
Installing the Plug-in

Symptom   You are not using the same Instant Messenger as the meeting organizer.

Possible Cause   You receive an invitation through an Instant Messaging session instructing you to 
contact your Sametime administrator to install the plug-in.

Recommended Action   Select the link in the invitation message to join the meeting through the 
web-based Cisco Unified Videoconferencing Connector interface without installing the plug-in.

Checking CPU Usage and Network Information
These status icons display at the bottom of the moderator live conference view.

Figure 6-1 Moderator Live Conference View Status Icons
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Procedure

Step 1 Check whether the CPU overload indicator is displayed or not. The CPU overload indicator shows that 
your CPU usage is too high and that video quality will become poor or stop completely.

Note If the CPU overload indicator is displayed, Cisco recommends that you exit other applications 
currently running on your computer to clear CPU resources.

Step 2 Select the Network icon to display the Local tab in the Current call section of the Conference Client 
Control Panel. For more information, see “Checking Endpoint Bandwidth Information” section on 
page 6-3. 

Note A tooltip on the network icon indicates the current send/receive rates, and whether or not 
tunneling is enabled. The tooltip is automatically updated approximately every two seconds.

Troubleshooting Conference Client
 • Checking System Settings and Call Log, page 6-2

 • Checking Endpoint Bandwidth Information, page 6-3

 • Configuring Audio Record Settings, page 6-6

 • Configuring Audio Playback Settings, page 6-7

 • Configuring Video Settings, page 6-7

 • Setting Network Bandwidth, page 6-8

 • Configuring Proxy Server Settings, page 6-8

 • Enabling Automatic Adjustment of Microphone Volume, page 6-9

 • Removing Echo, page 6-9

 • Increasing Video Compression, page 6-9

 • Selecting Preferred Image Size, page 6-10

 • Connecting Only to a Trusted Server, page 6-10

 • Sending RTP Media Packets Using TCP, page 6-11

Checking System Settings and Call Log
You can check the system settings for such modules as services, codecs, filters, and other small 
applications as well as their versions.
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Procedure

Step 1 Right-click the Conference Client Control Panel Icon  .

Step 2 Select About.

The Information window opens (Figure 6-2). The System Information area displays information about 
your computer, system hardware and software.

Figure 6-2 Information Window

Step 3 If necessary, select View Call Log.

Checking Endpoint Bandwidth Information
 • Checking Local Endpoint Bandwidth Information, page 6-4

 • Checking Remote Endpoint Information, page 6-5
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Checking Local Endpoint Bandwidth Information

You can check the bandwidth that your Conference Client sends and receives. 

Procedure

Step 1 Right-click the Conference Client Control Panel Icon  .

Step 2 Select Settings.

The Settings window opens.

Step 3 Select the Network tab.

Figure 6-3 Network tab
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Checking Remote Endpoint Information

You can check the status of other meeting participants and the bandwidth that their endpoints send and 
receive. The Remote tab also lists the name of the user and the details of the meeting. 

Procedure

Step 1 Right-click the Conference Client Control Panel Icon  .

Step 2 Select Current call.

Step 3 Select the Remote tab.

Figure 6-4 Conference Client Control Panel: Current Call—Remote Tab
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Note You cannot make changes while participating in a meeting.

Configuring Audio Record Settings

Symptom   The quality of audio that your endpoint sends is low.

Possible Cause   The audio settings used by your Conference Client are not optimal.

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Audio tab.

Step 4 To set your microphone settings, select the required recording device from the Device list in the Record 
pane:

 • Line In—For a microphone with a line-in connector

 • Internal Mic

 • External Mic

Step 5 Select the required audio input source from the Line list in the Record pane.

Step 6 To set the required volume level, use the slider in the Record pane.

Table 6-1 Remote Call Status and Bandwidth  

Name The name of the remote participant. 

Note Your endpoint displays in the list. 

Kb/s The data that you receive from the remote participant.

Maximum send and 
receive rates 

The maximum send and receive rates of the remote participants. Low values 
can explain low-quality audio or video from a participant.

Loss sent and received The number of received packets that are lost from the remote participant. 
With a bad connection or saturated bandwidth, the packet loss increases and 
explains low-quality audio or video from a participant.

 Frames per second 
(Frm/s)

The number of frames per second being received from the remote 
participant. It also indicates the number of frames that you send from your 
endpoint.
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Step 7 To amplify your microphone input, select the Microphone Boost check box.

Step 8 Select Apply.

Configuring Audio Playback Settings

Symptom   The quality of audio that your endpoint receives is low.

Possible Cause   The audio playback settings used by your Conference Client are not optimal.

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Audio tab.

Step 4 Select the required playback device from the Device list in the Playback pane.

Step 5 To set the required volume level, use the slider in the Playback pane.

Step 6 Select Save.

Configuring Video Settings

Symptom   The quality of video that your endpoint sends is low.

Possible Cause   The video settings used by your Conference Client are not optimal.

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Video tab.

Step 4 If necessary, select the required recording device in the Capture pane.

Step 5 To modify settings:

a. Select Source in the Capture pane.

The Properties dialog box displays.

b. Modify camera settings as required, and then select Close to return to the Video tab.

Step 6 To set the required video quality, use the slider in the Capture pane.
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Setting Network Bandwidth

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Network tab.

Step 4 In the Bandwidth pane, select a bandwidth option:

a. Select Automatic from the list.

The Automatic option enables the Conference Client to set its own bandwidth.

-or-

b. Select one of these options and enter values for send and receive rates:

 • Modem 56K

 • ISDN 64K

 • ISDN 128K

 • Cable/DSL Low

 • Cable/DSL High

 • T1

 • LAN

Step 5 Select Save.

Note Your choice automatically sets your maximum send and receive rates. 

Configuring Proxy Server Settings
The Conference Client uses the proxy server settings of Internet Explorer when the proxy type is set to 
“Automatic.” However, if you need to change the proxy type and disable the use of a proxy server, or 
specify settings manually.

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Network tab.

Step 4 Select an option from the Proxy type list in the Proxy pane.

Step 5 Enter the required proxy server information in the relevant fields. 

Step 6 Select Apply. 
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Enabling Automatic Adjustment of Microphone Volume

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Advanced tab.

Step 4 Select the Automatic Gain Control check box.

Step 5 Select Apply.

Removing Echo

Symptom   The echo (sound reverberation) is heard in received audio.

Possible Cause   Typically, echo originates from the microphone transmitting the same sound that 
your speakers are playing. Increasing the distance between your speakers and microphone can also 
reduce echo.

Cisco strongly recommends that you perform this procedure on your Cisco Unified 
Videoconferencing Connector.

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Advanced tab.

Step 4 Select the Echo Cancellation check box under Audio.

Step 5 Select Apply.

Increasing Video Compression
You can increase the video compression rate for improved performance over the network, but using this 
option might result in a blurred video image. 

Note Do not use this option if your video capture device is of very high quality. 
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Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Advanced tab.

Step 4 Select the Video Capture Noise Reduction Filter check box under Video.

Step 5 Select Apply.

Selecting Preferred Image Size
You can select the size of the video image that you want to send by using the Preferred image size 
option. 

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Advanced tab.

Step 4 Select your preferred video size from the list in the Preferred Video Size field under Video.

Step 5 Select Preview in the Video tab to see the effects of this setting.

Cisco recommends that you select the High Definition option.

Connecting Only to a Trusted Server
You can instruct the Conference Client to connect only to a Desktop server with a trusted certificate 
installed. This setting is disabled by default.

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Advanced tab.

Step 4 Select the Connect Only To Trusted Server check box under Network.

Note Because the Desktop server ships with a self-signed certificate which is not trusted, checking 
this option with a default installation causes the Conference Client to fail to connect to the 
server. Administrators can replace the default self-sign certificate as required.
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Sending RTP Media Packets Using TCP 
You can instruct the Conference Client to send RTP media packets using TCP, rather than using UDP.

Procedure

Step 1 If you are in a video meeting, leave it.

Step 2 Access the Conference Client.

Step 3 Select the Advanced tab.

Step 4 Select the Use TCP To Transport Media check box under Network.

Step 5 Select one of these options:

 • Automatic—Desktop tries to send media over UDP, and then switches to TCP if the UDP ports are 
not open.

 • Always On—On connecting, Desktop sends media using TCP.

 • Always Off—Desktop always attempts to send media using UDP.

Note To enable Desktop to work with encryption, a TCP connection is required.
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